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Création de votre premier matériau : le verre
Après avoir modélisé une carafe, nous allons nous attacher à comprendre
comment la mettre en « couleurs », c’est-à-dire lui donner les propriétés
visuelles qui vont permettre à notre cerveau de l’identifier comme étant
constituée de verre.

Création d’un nouveau matériau
Avec le bouton droit de la souris, sélectionnez la carafe, puis affichez la
fenêtre des boutons relatives au shading grâce à la touche [F5]. Normale-
ment, les Material buttons s’affichent automatiquement, conformément à
l’illustration qui suit.

Le panneau de gauche, Preview, nous permettra de prévisualiser les maté-
riaux en cours d’édition. Aucun matériau n’étant pour l’instant associé à la
carafe, il est donc compréhensible qu’il soit vide. Le panneau suivant,
Material, est également plutôt vide, mais contient un bouton Add New : en
cliquant dessus, vous créez un nouveau matériau, dont tous les paramètres
ont les valeurs par défaut, et évoquent une sorte de plastique gris assez peu
intéressant. Vous noterez que, par défaut, il s’appelle Material. Cliquez
sur le champ MA:Material, effacez le nom présent, puis remplacez-le par
quelque chose de plus explicite, comme Verre.

Nous n’allons pas tarder à voir comment changer la couleur de notre
matériau, mais dans un premier temps, intéressons-nous au panneau de
prévisualisation, qui nous montre un carré d’un gris peu engageant.
Repérez le bouton représentant une sphère jaune, et cliquez dessus ;
Blender affiche désormais une grosse boule grise qui occupe l’essentiel
du panneau. Cliquez également sur le dernier bouton (un cercle gris)
pour activer l’anticrénelage et lisser la prévisualisation.

Vous pouvez soit démarrer sur la base de votre propre carafe, soit
charger le fichier exercice-ch03.01-final.blend présent dans le
répertoire /exercices du DVD-Rom d’accompagnement.

Figure 3–36 L’objet est pour l’instant vierge de tout matériau.

Options du panneau de prévisualisation

Sur le côté droit du panneau de prévisualisation se
trouve une série de boutons rangés verticalement :
• le premier (carré rouge, par défaut) permet de

réaliser un essai d’affichage du matériau en
cours d’édition sur un plan ; 

• le second (petite sphère jaune) l’affiche sur une
sphère ; 

• le troisième (cube gris) l’affiche sur un cube ; 
• le quatrième (petite tête de singe rouge)

l’affiche sur une primitive complexe en forme
de tête de singe ; 

• le cinquième l’affiche sur des mèches (utile
pour les particules statiques) ; 

• le sixième (une autre sphère jaune) l’affiche sur
une grosse sphère. 

Toutes les primitives sont munies d’un environne-
ment à refléter, à l’exception de la deuxième
sphère jaune, qui présente un simple « ciel »
comme environnement. Choisir une forme évo-
quant au plus près celle de l’objet en cours d’édi-
tion est souvent utile pour mieux juger de l’allure
du matériau.
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Changement de la couleur
L’onglet Material présente toute une série de boutons et de curseurs qui
peuvent vous paraître intimidants, mais les choses sont relativement
simples à utiliser au début. Pour changer la couleur du matériau, il suffit
de changer la valeur des trois composantes de couleur rouge, vert et bleu
qui, par mélange, donneront la couleur finale voulue. Ces composantes
sont représentées par les curseurs R (Red, rouge), G (Green, vert) et B
(Blue, bleu). Par exemple, pour obtenir un léger vert d’eau (idéal pour
notre matériau), nous allons spécifier les composantes suivantes :
R 0.700, G 0.950, B 0.700.

Ajouter de la transparence
Le panneau de prévisualisation est désormais mis à jour, mais nous n’en
avons pas encore fini : nous souhaitons créer un matériau transparent. Il
existe encore un curseur gérant le taux de transparence du matériau, et
dont la composante porte le nom A (Alpha). Plus la valeur est basse, plus
le matériau est transparent. Avec A 0.00, l’objet est totalement invisible ;
avec A 1.00, il est totalement opaque. Pour notre matériau de verre, nous
choisirons une valeur très faible, mais non nulle. Par exemple, A 0.03 et
nous activerons l’option ZTransp dans le panneau Links and Pipeline.

Vous pouvez si vous le souhaitez effectuer un rendu de la scène
(touche [F12]) pour observer votre matériau de verre dans un environne-
ment « réel » plutôt que dans un panneau de prévisualisation. Le résultat
vous paraîtra des plus surprenants : la carafe est tout simplement bleue et
ne présente absolument pas, par transparence, l’arrière-plan prévu !

Figure 3–37
La prévisualisation en temps réel de votre

matériau sur une primitive de votre choix :
plan, sphère, cube, tête de singe, mèches

(strands), sphère avec un ciel

ASTUCE   Spécifier la couleur

Vous avez plusieurs options pour modifier la cou-
leur de votre matériau.
• Utiliser les curseurs : vous pouvez, avec le

bouton gauche de la souris, déplacer indivi-
duellement chaque curseur.

• Saisir les valeurs numériques : en cliquant
avec le bouton gauche sur la valeur du
bouton, vous pouvez l’éditer à l’aide du clavier.

• Utiliser l’éditeur de couleurs : en cliquant
sur les nuanciers à gauche des boutons Col,
Spe et Mir, vous pouvez appeler un outil gra-
phique d’édition des couleurs qui vous per-
mettra de choisir directement la couleur
souhaitée.

Figure 3–38 Le sélecteur de couleurs intégré 
à Blender

Figure 3–39
L’option ZTransp configurée

dans les Material Buttons
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Les modes de transparence

Blender permet de travailler selon trois modes distincts de transparence.
• Transparence Alpha : la couleur du matériau est mélangée à celle du World dans les proportions suggérées par la valeur Alpha du matériau. C’est

le comportement par défaut, et c’est ce qui se passe ici : si vous cliquez sur le bouton appelant les World buttons, vous verrez dans le panneau de
prévisualisation que le « monde » est de couleur bleue.

Figure 3–40 La « transparence » ne révèle que le World de la scène plutôt que l’arrière-plan.

• Transparence Z : au moment du rendu, plutôt que de mélanger la couleur de l’objet à celle du World, Blender va la mélanger avec celle de
l’arrière-plan. Pour ce faire, consultez le panneau Links and Pipeline et activez le bouton ZTransp.

Figure 3–41 Cet effet de transparence évoque plus un objet pratiquement invisible qu’un matériau transparent.

• Transparence et raytracing : non seulement, au moment du rendu, Blender va mélanger la couleur de l’objet avec celle des objets en arrière-plan,
mais en plus, des options vont permettre d’activer la distorsion des objets observés au travers du verre. Dans l’onglet Mirror Transp repérez puis
activez le bouton Ray Transp.

Figure 3–42 Grâce au raytracing, la transparence tient compte de la distorsion de la lumière au travers du verre, pour un résultat plus réaliste.
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Ne vous inquiétez pas : il y a une explication logique à votre déception. Il
existe plusieurs modes de transparence gérés par Blender, mais pour notre
exemple, nous allons choisir la méthode de transparence avec raytracing.
Pour cela, activez le bouton Ray Transp dans l’onglet Mirror Transp, spécifiez
un IOR de 1.55 pour notre matériau de verre, ainsi qu’un Depth de 10 (atten-
tion, il y a deux champs Depth, l’un concernant les propriétés de Ray Mirror,
et placé dans la colonne correspondante, et un autre pour les propriétés Ray
Transp, également placé dans la colonne correspondante). Pour faire bonne
mesure, nous donnerons également une petite valeur au paramètre Filt (pour
Filter, filtre) : 0.050. Les paramètres Limit et Falloff (relatifs à la transmissi-
vité du matériau) seront laissés à leur valeurs par défaut.

Choix des shaders
Nous pourrions nous en arrêter là, le résultat étant satisfaisant, mais il
est possible d’améliorer encore un peu le réalisme du matériau, en spéci-
fiant et en réglant les shaders du matériau. Blender propose en effet
divers modèles de shaders. Les Diffuse shaders affectent uniquement la
couleur de base du matériau, tandis que les Specular shaders affectent
l’intensité et l’étendue des taches spéculaires (les reflets lumineux à la
surface d’objets vernis, par exemple).

Le choix entre les différents modèles de shaders est effectué dans
l’onglet Shaders, qui partage le même panneau que l’onglet Mirror Transp.

Figure 3–43
Les propriétés de transparence du verre

Remarque : les ombres des objets transparents

Si nous avons maintenant un matériau de verre correct, force est de
constater que l’ombre projetée sur le mur (et les autres objets) n’est
guère réaliste : les ombres des objets sont généralement aussi translu-
cides que les objets sont transparents. Ici, en revanche, les ombres sont
pleines et solides, comme si elles étaient projetées par des objets totale-
ment opaques. Pour corriger cela, il faut activer le bouton TraShadow
dans le panneau Shaders des objets recevant les ombres transparentes.

LE SAVIEZ-VOUS ?  

Le moteur de rendu OpenGL qui permet l’affichage
ombré dans les vues 3D utilise le célèbre ombrage
de Gouraud, qui permet d’éclairer la surface des
objets sans recourir à un calcul systématique de
l’illumination de chaque pixel, ce qui grèverait
sérieusement les performances de votre ordinateur.
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La première ligne permet de définir le Diffuse shader, la seconde déter-
mine le Specular shader. Nous allons dans cet exercice totalement ignorer
les autres boutons et curseurs existants. Cliquez sur le menu déroulant
présentant actuellement l’option Lambert, et choisissez Oren-Nayar en
lieu et place, comme nouveau Diffuse shader. Le matériau étant transpa-
rent, il paraît logique qu’il ne reflète que peu de lumière, et donc que sa
valeur de Ref soit faible. Qui plus est, il s’agit d’un matériau naturelle-
ment lisse, donc sa valeur de Rough devrait également être faible : en
conséquence, diminuez la valeur de Ref à 0.10, et Rough à 0.05.

Passons maintenant au Specular shader. Nous allons conserver le shader Cook-
Torr présenté par défaut dans le menu déroulant. Comme nous souhaitons que
les reflets lumineux soient prononcés, nous augmenterons la valeur Spec ; de
même, nous souhaitons que les taches lumineuses soient très « dures » sur les
bords, nous augmenterons donc la valeur Hard : en conséquence, nous utilise-
rons une valeur de Spec égale à 1.25 et une valeur de Hard égale à 85.

Rendre le matériau réflectif
Nous pouvons encore affiner le matériau de verre en lui donnant quelques
propriétés réflectives, de sorte que l’environnement de la carafe soit visible
dans les reflets du verre. Pour cela, nous allons retourner dans l’onglet Mirror
Transp, et activer le bouton Ray Mirror. Le seul paramètre que nous change-
rons sera Ray Mir, et nous lui donnerons une faible valeur, comme 0.10.

Vous trouverez sur le DVD-Rom d’accompagnement le fichier
exercice-ch03.02-final.blend dans le répertoire /exercices.

Figure 3–44
Les options de shaders par défaut

Figure 3–45
Nos shaders Diffuse et Specular

Au sujet des options de raytracing

Dès lors que vous activez des options de shading
ou d’éclairage propres au raytracing, il vous faut
explicitement activer celui-ci dans les options de
rendu. Dans le menu Scene, touche F10], activez
le bouton Ray dans le panneau Render.

Figure 3–46
Les propriétés de réflexion du verre
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chapitre 4

Seiko Chronograph, © 2004 par Zsolt Stefan : http://deeppixel.uw.hu/gallery.html
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Techniques de modélisation

L’art de la modélisation est un genre à part dans l’imagerie de 
synthèse. De bons modèles sont nécessaires pour inspirer 
réalisme, atmosphère ou émotions. Ce chapitre vous présente 
les outils que Blender met à votre disposition pour remplir 
cette fonction. Blender est parfaitement à l’aise avec la 
modélisation polygonale, et fournit dans ce domaine de 
nombreux outils qui vont de l’utile à l’indispensable. Il permet, 
malgré tout, de modéliser à l’aide de courbes, de surfaces 
mathématiques (Bézier ou NURBS), ou encore de méta-
éléments qui fonctionnent un peu à la façon de gouttes de 
mercure qui s’agglomèrent selon vos souhaits. Ce chapitre 
n’aura pas la prétention de vous apprendre à modéliser ; pour 
cela, il vous faudra écumer les forums d’utilisateurs, étudier les 
maillages de leurs modèles lorsqu’ils les mettront à disposition 
ou en montreront une vue en mode fil de fer, suivre de 
nombreux didacticiels... Il n’y a pas de secret, car même avec 
un document vous expliquant pas à pas comment modéliser, 
par exemple, un corps humain de façon réaliste, il vous faudra 
retrousser les manches. Ce chapitre a pour seule ambition de 
vous donner les outils pour y arriver, de vous concentrer sur la 
finalité plutôt que sur le moyen.

SOMMAIRE

B Polygones, NURBS, 
méta-éléments

B Courbes, objets textes, 
modificateurs

MOTS-CLÉS

B Sommets
B Facettes
B Arêtes
B Courbes
B Bézier
B NURBS
B Primitives
B Subsurf
B Booléens
B Boucles d’arêtes
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Modélisation polygonale
La modélisation polygonale est un très vaste sujet, Blender étant doté de
nombreux outils dans ce domaine. Le contenu de ce chapitre n’est mal-
heureusement qu’un aperçu de ce qui est possible, l’expérience et une
bonne connaissance du logiciel permettant souvent d’obtenir des résul-
tats quasi similaires par divers moyens, plus ou moins complexes.

Les primitives
Blender propose un certain nombre de primitives prêtes à l’emploi. Les
associer permet de construire des objets simples, ou de s’en servir comme
base à des objets plus complexes. Pour ajouter une nouvelle primitive, il
faut passer par le menu Add de la barre principale, ou par la boîte à outils
([Espace]>Add>Mesh), puis choisir la primitive à insérer. La nouvelle pri-
mitive est automatiquement en mode Edit lors de son insertion, tous ses
sommets étant sélectionnés. Certaines primitives possèdent des paramè-
tres qu’il faut au préalable définir avant qu’elles ne soient affichées.
• Plane : insère un objet de type plan. Cette primitive est souvent le point

de départ de toute modélisation, l’utilisateur supprimant tous les som-
mets sauf un, et ajoutant des sommets ([Ctrl]+bouton gauche de la
souris) en construisant des faces au fur et à mesure (touche [F] avec au
moins trois sommets sélectionnés). Cet objet n’a pas d’épaisseur.

• Cube : insère un objet de type cube. Cette primitive est souvent le
point de départ des modélisations à base d’extrusion, où l’utilisateur
décrit d’abord des formes simples avant de détailler celles-ci à l’aide
des outils couteau (touche [K]) et extrusion (touche [E]).

ASTUCE   Appel de la boîte à outils

Outre passer par le menu Add, vous pouvez
recourir à l’une des trois méthodes suivantes pour
appeler la boîte à outils de Blender :
• touche [Espace] ;
• combinaison de touches [Maj]+[A] ;
• pression continue sur le bouton gauche de la

souris.

Figure 4–1
Un objet de type plan

Figure 4–2
Un objet de type cube
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• Circle : insère un simple cercle. À l’appel de cette primitive, Blender
demande le nombre de sommets (Vertices) devant constituer le cercle ;
un minimum de trois sommets est bien sûr nécessaire pour constituer
un profil clos. Les sommets sont reliés les uns aux autres par des arêtes,
mais par aucune face. De plus, l’objet n’a aucune épaisseur. En consé-
quence, il n’apparaît normalement pas lors des rendus, et n’est souvent
que le point de départ de modélisations plus complexes. Vous pouvez
également spécifier le rayon (Radius) du cercle. Enfin, l’option Fill
permet de clore la surface, transformant le cercle en disque.

• UVsphere : insère un objet de type sphère. Cette primitive est consti-
tuée de facettes quadrangulaires ; la résolution de la sphère (le
nombre de facettes la constituant) est déterminée interactivement par
les paramètres Segments et Rings, lors de l’appel de cette primitive.
Vous pouvez également spécifier le rayon (Radius) de la sphère.

• Icosphere : insère également un objet de type sphère, toutefois consti-
tuée de facettes triangulaires ; augmenter le nombre de subdivision
permet d’augmenter la résolution de l’icosphère. Icosphere produit des
résultats très proches d’UVsphere mais avec un maillage plus écono-
mique en sommets pour une précision en surface à peu près équiva-
lente. Vous pouvez également spécifier le rayon (Radius) de la sphère.

Figure 4–3
Un objet de type cercle

Figure 4–4
Un objet de type sphère

3DS MAX   Primitive Géosphère

Dans 3ds max, il est possible de créer des
géosphères : sphères à base de trigones. Il existe
trois bases géodésiques (déploiement du maillage)
de type :
• tetra ;
• octa ;
• icosa.
Le type icosa est l’équivalent de l’icosphère dans
Blender.
Si l’on regarde le sommet de la géosphère, on
remarque que celle-ci est composée de trois tran-
ches pour le type tetra, quatre pour l’octa et cinq
pour l’icosa.
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• Cylinder : insère un objet de type cylindre. Cette primitive a une base
circulaire, qui se définit de la même façon que pour la primitive Circle,
grâce aux paramètres Vertices et Radius. Elle possède toutefois un para-
mètre supplémentaire, la longueur du cylindre (Depth), ainsi que la
possibilité de fermer ses extrémités par des facettes (option Cap Ends).

• Cone : insère un objet de type cône, de base circulaire ; il est défini
exactement de la même façon que la primitive Cylinder, excepté qu’il n’y
a qu’une seule extrémité, qui peut ou non être close par des facettes
(option Cap Ends). Le cône pourrait être un cylindre dont tous les som-
mets de la face supérieure auraient été fondus en un point central.

Figure 4–5
Un objet de de type icosphere

La primitive Tube

Elle n’existe plus dans Blender ; pour créer un
maillage de type tube, ajoutez un maillage de type
Cylinder et désactivez l’option Cap Ends : le
cylindre qui sera affiché ne sera pas fermé à ses
extrémités.

Figure 4–6
Un objet de type cylindre

3DS MAX   Primitive Pyramide

Elle n’a pas d’équivalent sous Blender mais peut
facilement être simulée par un cône dont le
nombre de Vertices est fixé à 4.

Figure 4–7
Un objet de type cône
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• Grid : insère un objet de type grille. Il pourrait s’agir d’un objet de
type plan dont la résolution serait déterminée individuellement dans
ses directions locales X et Y.

• Monkey : insère un objet de type tête de singe. En fait, ce modèle a un
prénom, Suzanne, et se trouve être la mascotte du logiciel Blender.
On ne compte pas le nombre de nouvelles fonctionnalités de Blender
testées sur la pauvre Suzanne à chaque innovation logicielle.

• Empty Mesh : insère un objet vide, doté d’une origine et d’un système
de coordonées locales. Fonctionnant à l’identique d’un simple Empty,
il offre la possibilité supplémentaire d’être matérialisé sous forme de
différentes primitives (cône, sphère, cube, cercle) ou de systèmes
d’axes (axes simples, flèche seule, flèches).

• Torus : insère un objet de type tore. Il s’agit en fait d’un cylindre (de
rayon égal à Minor Radius, et composé d’un nombre de segments égal
à Minor Segments) courbe rebouclant sur lui-même, au terme d’une
trajectoire circulaire (de rayon égal à Major Radius, et composée d’un
nombre de segments égal à Major Segments).

Figure 4–8
Un objet de type grille

Figure 4–9
Le modèle Suzanne, mascotte de Blender

Figure 4–10
Un objet de type tore
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Les outils de modélisation de base
Ce sont des fonctions qui seront fréquemment invoquées par l’utilisateur
débutant, et qui lui donneront déjà une certaine autonomie par rapport à
la simple utilisation des primitives abordées jusqu’à présent.

Joindre deux maillages
Il arrivera fréquemment que vous construisiez des ensembles de formes à
l’aide de primitives, et que vous désiriez à la fin (ou à n’importe quel
moment du processus de modélisation) joindre les différents objets dis-
tincts au sein d’un même objet. Pour cela, vous sélectionnerez un pre-
mier objet avec le bouton droit de la souris, puis en maintenant la
touche [Maj] pressée, vous ajouterez d’autres objets à la sélection, tou-
jours avec le bouton droit de la souris. La combinaison de touches
[Ctrl]+[ J] ([ J] pour Join, joindre) vous permet de rassembler tous ces
objets en un seul ; en mode Edit, vous remarquerez que la nouvelle entité
sera constituée des maillages de chacun des objets, chacun demeurant
distinct. L’objet résultant portera le nom du dernier objet ajouté à la
sélection, et son centre sera le centre de ce même dernier objet.

ASTUCE  Déplacer les centres des objets

Suite à diverses opérations de fusion ou de séparation de maillages, vos objets peuvent se
retrouver avec des centres éloignés du centre géométrique théorique du maillage, ou simple-
ment de l’endroit où vous auriez pu souhaiter le placer. Dans le panneau Mesh du
menu Editing, vous trouverez trois boutons qui, hors du mode Edit, vous permettront de
positionner différemment le centre de l’objet.
• Centre : si le centre est éloigné du centre géométrique théorique de l’objet, le maillage de

l’objet est déplacé de sorte à ce que son centre géométrique corresponde avec le centre
distant. C’est le maillage qui est déplacé, et non le centre !

• Centre New : si le centre est éloigné du centre géométrique théorique de l’objet, le centre
distant est déplacé pour correspondre avec le centre géométrique de l’objet. Cette fois,
c’est le centre qui est déplacé, et non l’objet.

• Centre Cursor : quelles que soient les positions du centre géométrique théorique ou du
centre effectif, la position du centre est redéfinie pour qu’elle coïncide avec la position du
curseur 3D.

Figure 4–11 Le panneau Mesh et les boutons de positionnement du centre d’un objet

ASTUCE  
Sélectionner les sommets liés entre eux

Comme nous venons de le voir, vous pouvez
ajouter à un maillage des groupes de sommets qui
ne sont pas forcément liés entre eux. Pour des
maillages complexes, il devient alors très difficile,
à un moment donné, de sélectionner un même
groupe de sommets uniquement grâce à la boîte
de sélection invoquée par la touche [B]. En
mode Edit, lorsqu’aucun sommet n’est sélec-
tionné, vous pouvez toutefois amener le curseur de
la souris à proximité d’un sommet en particulier, et
utiliser la touche [L] (pour Linked, liés). Si vous
êtes suffisamment proche (un message « Error:
Nothing indicated » étant retourné par
Blender, dans le cas contraire), le sommet en ques-
tion ainsi que tous les sommets qui lui sont liés par
des arêtes sont automatiquement sélectionnés.
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Séparer un maillage pour former deux objets distincts
Il s’agit bien évidemment de l’opération inverse de la précédente. En
mode Edit, sélectionnez un groupe de sommets par la méthode de votre
choix (sélection directe avec le bouton droit de la souris, boîte de sélec-
tion avec la touche [B], sélection des sommets liés avec la touche [L],
etc.), appuyez sur la touche [P] et choisissez l’option Selected. La sélec-
tion est alors séparée du maillage en cours d’édition. Le nouvel objet
séparé conserve le même centre que l’objet d’origine, et prend un nom
dérivé du précédent (par exemple, OB:Voiture devient OB:Voiture.001).

La fonction Separate admet trois options :
• Selected : sépare la sélection courante de sommets du maillage en

cours d’édition ;
• All Loose Parts : un objet peut être constitué de plusieurs maillages qui

ne sont pas reliés entre eux par des arêtes ou des facettes ; cette option
permet de les séparer automatiquement ;

• By Material : lorsqu’un même objet s’est vu attribué plusieurs maté-
riaux grâce aux indices matériau (voir chapitre 5, Maîtriser les maté-
riaux de Blender), cette fonction permet de créer des maillages
distincts pour chaque indice matériau.

Extrusion
L’opération d’extrusion se réalise en mode Edit, sur une facette unique,
ou sur un groupe de facettes. Elle consiste à générer un volume allongé
pour donner une forme tridimensionnelle à la facette d’origine.

L’opération d’extrusion est commandée par la touche [E] ou par le
menu Mesh>Extrude. Il existe plusieurs modes d’extrusion, comme en
témoigne la boîte de dialogue qui apparaît lorsque l’opération est lancée.
Les options disponibles dépendent de la sélection et du mode de sélec-
tion (Vertex select mode, Edge select mode et Face select mode).

Figure 4–12
Le menu de la fonction Separate, touche [P]

3DS MAX   Modificateurs Extrusion et Tour

Extrusion et Tour ne se présentent pas sous forme
de modificateurs dans Blender, mais sous forme
d’outils de modélisation. Il en résulte que le
maillage, une fois généré par les fonctions
Extrude ou Spin de Blender, ne peut être redéfini
interactivement.

Figure 4–13
À gauche, un simple plan de forme irrégulière, 
et à droite, le volume généré par extrusion du plan
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• Region : il s’agit du mode d’extrusion par défaut. La sélection est
extrudée le long de la normale moyenne du groupe de facettes. Les sur-
faces aux extrémités du volume extrudé sont rigoureusement identiques.

Figure 4–14
La boîte de dialogue de la fonction d’extrusion

ASTUCE   Les outils de sélection basés sur la dureté ou la planéité des arêtes

Deux outils existent pour faciliter la vie des modeleurs lorsqu’ils réa-
lisent des modèles techniques et/ou mécaniques. Ils fonctionnent par
comparaison des angles formés par les arêtes ou les facettes adja-
centes.
Le premier outil (Select Sharp Edges) permet de sélectionner les arêtes
qui forment des angles vifs, l’angle limite pouvant être fixé par l’utilisa-
teur. Il s’utilise en mode de sélection des sommets ou des arêtes, et est
appelé grâce à la combinaison de touches [Ctrl]+[Alt]+[Maj]+[S]. Il
sélectionne automatiquement toutes les arêtes répondant au critère
angulaire ; aucune sélection initiale n’est donc nécessaire. Par exemple,
en mode Edge Select, cet outil appliqué à un cylindre standard, va
retourner l’angle vif formé entre le corps cylindrique et les deux faces
planes.

Figure 4–16
Sélection des arêtes en mode Edge Select

Le second outil (Select Linked Flat Faces) permet de sélectionner
l’ensemble des facettes qui forment des angles très faibles les unes par
rapport aux autres, l’angle limite pouvant également être fixé par l’uti-
lisateur. Il s’utilise uniquement en mode de sélection des facettes, et est
appelé grâce à la combinaison de touches [Ctrl]+[Alt]+[Maj]+[F]. Il
sélectionne automatiquement toutes les arêtes répondant au critère
angulaire, le test étant toutefois réalisé par rapport à une facette de
référence, qui devra donc être sélectionnée au préalable. Par exemple,
en mode Face Select, cet outil appliqué à un cylindre standard, avec
une des facettes constituant l’enveloppe cylindrique sélectionnée, va
retourner le corps du cylindre entier.

Figure 4–17
Sélection des facettes en mode Face Select

Figure 4–15
Exemple d’extrusion d’un

 groupe de facettes en mode Region
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• Individual Faces : chaque face est extrudée selon sa propre normale. Il
en résulte que chaque facette engendre son propre volume extrudé.

• Only Edges : identique au mode Region, à ceci près que le volume
généré n’est pas clos par une facette, mais reste ouvert.

Figure 4–18
Exemple d’extrusion d’un groupe de facettes 
en mode Individual Faces (facettes individuelles)

Figure 4–19
Exemple d’extrusion d’un groupe de facettes 
en mode Only Edges (arêtes seulement)

ASTUCE  Shrink et Fatten

Littéralement, il s’agit des fonctions diminuer et grossir. C’est un mode de transformation
cousin tenant à la fois de l’outil d’extrusion et de celui de redimensionnement. En utilisant la
combinaison de touches [Alt]+[S], vous activez le mode Shrink/Fatten ; la sélection est
alors redimensionnée proportionnellement à sa distance par rapport au centre de l’objet. Si
vous déplacez le curseur de la souris vers le centre, la sélection sera diminuée ; si vous l’éloi-
gnez, elle sera grossie. Le bouton gauche de la souris ou la touche [Entrée] valide l’action,
tandis que le bouton droit ou la touche [Echap] l’annulent.

Figure 4–20 La fonction Shrink (à gauche) et Fatten (à droite) produisent des résultats 
voisins de l’extrusion, mais avec une augmentation ou une diminution de la surface de 
la seconde extrémité

ASTUCE   L’outil pousser/tirer (Push/Pull)

Cet outil fonctionne en mode Edit, sur une sélec-
tion de points de contrôle. En utilisant la combi-
naison de touches [Maj]+[P], vous pouvez forcer
le redimensionnement de la sélection. À la diffé-
rence, toutefois, de la touche [S] qui redimen-
sionne la sélection de façon homothétique, Push/
Pull dilate celle-ci plus que ne la redimensionne,
en déplaçant tous les points de contrôle de la
même distance par rapport au barycentre de la
sélection.
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• Only Vertices : identique au mode Only Edges, à ceci près que seuls les
sommets et les arêtes sont générés, pas les facettes.

Objets de révolution : fonction Spin
La fonction Spin permet de générer un objet de révolution en trois
dimensions par rotation d’un groupe de facettes en deux dimensions.

En mode Edit, dans le menu Editing, touche [F9], un nouveau
panneau Mesh Tools fait son apparition. Il contient de nombreux outils
de modélisation. Avec tous les sommets d’un profil clos sélectionnés,
vous pouvez spécifier l’angle sur lequel sera projeté le profil grâce au
paramètre Degr (par défaut 90° ; pour un objet de révolution complet,
choisissez 360°), et en combien d’étapes (chaque étape représentera un
segment de rotation) grâce au paramètre Steps (par défaut 9 ; augmentez
ce nombre pour améliorer la résolution de l’objet de révolution).

Au moment de cliquer sur le bouton Spin, le curseur de la souris se trans-
formera en une sorte de point d’interrogation. Blender attend en fait que
vous cliquiez dans la vue 3D, définissant ainsi le plan de rotation du
futur objet de révolution. À noter que le centre de rotation sera le cur-

Figure 4–21

Figure 4–23 Au premier plan, un profil qui sert à construire, par rotations successives, 
l’objet de révolution qui se trouve à l’arrière-plan.

BON À SAVOIR  Sommets en double

Lorsque vous commandez une opération Spin sur
360°, le dernier profil créé coïncide avec le profil
d’origine. Lors du rendu ou dans la vue ombrée, un
mauvais ombrage des facettes peut être constaté
en raison de la mauvaise interprétation des nor-
males, en particulier lorsque le modificateur Sub-
surf est actif. La solution consiste à :

1. sélectionner tous les sommets de l’objet de
révolution et supprimer les sommets en double
grâce au bouton Rem Doubles du
panneau Mesh Tools ;

2. recalculer les normales de l’objet, grâce à la
combinaison de touches [Ctrl]+[N].

ASTUCE   Outil de sélection par chemin

Cet outil nécessite d’avoir deux sommets quelcon-
ques sélectionnés au sein d’un même maillage, et
d’être appelé par la touche [W] en choisissant
l’option Path Select. L’outil va alors évaluer
toutes les arêtes partant et arrivant à ces deux
sommets pour déterminer le chemin d’arêtes le
plus court. Deux méthodes d’évaluation sont
proposées : la première calcule la distance phy-
sique la plus courte, la seconde calcule la distance
la plus courte du point de vue topologique. Dans
les deux cas, le chemin calculé se transforme en
sélection.

Figure 4–22 Le panneau Mesh Tools
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seur 3D. Pour créer un objet typique, il vous faudra donc, par exemple,
bâtir votre profil dans la vue de face ou de côté (touches [1] ou [3] du
pavé numérique), positionner le curseur 3D sur l’axe de rotation dans la
vue de dessus (touche [7] du pavé numérique), et après avoir cliqué sur le
bouton Spin, indiquer la vue de dessus.

Profils hélicoïdaux : fonction Screw
Cette fonction est un dérivé de la fonction Spin, car en plus de faire
tourner un profil, elle le translate d’une certaine distance à chaque tour
réalisé. Il s’agit de la fonction idéale pour réaliser un filetage ou un
simple ressort. En mode Edit, dans une vue orthogonale (touches [1], [3]
ou [7]) vous ajouterez :
• un profil : il s’agira de la forme qui tournera autour de l’axe de

révolution ;
• un segment : il a une importance cruciale, et peut ne comporter que

deux points reliés par une arête. Sa longueur (projetée sur l’axe ver-
tical de la vue) définit tout simplement le « pas » de translation du
profil à chaque tour ;

• un centre de rotation : celui-ci est défini par le curseur 3D, comme
précédemment.

Comme précédemment, le bouton numérique Steps indique la résolution
de l’objet de révolution sur un tour. Pour sa part, le bouton
numérique Turns indique le nombre de tour que doit faire le profil tout
en étant translaté selon la direction indiquée par le segment.

Comme pour la fonction Spin, au moment d’activer la fonction Screw, le
pointeur de la souris se transformera en un point d’interrogation pour
demander à l’utilisateur dans quelle vue 3D l’opération doit être réalisée.

ATTENTION   Soyez procédurier !

Pour l’emploi de la fonction Spin, il convient
d’être méthodique et procédurier. Lancez la
commande dans une vue non orthogonale (une
vue autre que [1], [3] ou [7]) peut donner à
votre objet des angles étranges ; de même, une
mauvaise position du curseur 3D peut entraîner
un trou à l’intérieur de votre objet de révolution
(c’est souvent un but recherché) ou, au con-
traire, des faces occupant le même espace (ce
qui ne présentera jamais de bons résultats lors
du rendu ni même dans les vues ombrées).

Figure 4–24
Un profil et un segment définissent 
la forme de révolution et le pas de translation.
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Duplication procédurale d’objets : fonctions DupliVerts et 
DupliFaces
Il s’agit à la fois d’une méthode de modélisation et d’une technique pour
cloner un grand nombre d’objets selon un arrangement particulier. Le
principe est relativement simple : vous spécifiez deux objets et l’un deux
sera dupliqué répétitivement à la surface de l’autre ; un clone pourra être
placé à chaque sommet de l’objet de base (fonction DupliVerts) ou au
centre de chacune de ses facettes (fonction DupliFaces).

La technique de base, en bref

Démarrez une nouvelle session de Blender (combinaison de
touches [Ctrl]+[X] pour réinitialiser à la scène par défaut), et supprimez
le cube central (sélection grâce au bouton droit de la souris, puis

ATTENTION  Surface générée par la rotation du segment

De par sa conception, cette fonction implique que le segment définissant à la fois le pas de
translation et le taux de changement de section de l’objet de révolution est lui aussi transformé
par la fonction. Supprimer cette surface en supprimant un à un les sommets, arêtes ou facettes
pourrait se révéler extrêmement fastidieux sans la touche [L] : désélectionnez dans un premier
temps tout sommet éventuellement sélectionné grâce à la touche [A] ; amenez ensuite le cur-
seur de la souris au-dessus de la surface à supprimer, mais n’utilisez aucun bouton. Appuyez
sur la touche [L] : tous les sommets liés entre eux à proximité immédiate de la souris sont
sélectionnés d’un coup. Vous pouvez maintenant les supprimer grâce à la touche [X].

ASTUCE  Objets à section variable

À noter que le segment peut ne pas être vertical, auquel cas son angle par rapport à la verti-
cale indique le taux d’augmentation ou de diminution de la section de l’objet de révolution à
chaque tour.

Figure 4–25
Un segment non vertical entraînera une variation de la section de l’objet de révolution.

3DS MAX   Objet composé Dispersion

La fonction DupliVerts est à ce jour la plus
proche de l’objet composé Dispersion de
3ds max, avec les limitations suivantes : Dupli-
Verts duplique systématiquement la géométrie de
l’objet source aux sommets de l’objet dit de distri-
bution. Il n’y a pas de possibilité de faire varier les
positions, les échelles ou les rotations de chaque
instance dupliquée, mais de telles possibilités
seront prochainement ajoutées au travers d’un
nouveau modificateur : Array. À noter que la
fonction DupliFaces permet de dimensionner
l’instance en fonction des dimensions de la facette
où elle apparaît.
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touche [X]). Insérez à la place un objet grille ([Espace]>Add>Mesh>Grid)
de résolution X res: 4 et Y res: 4. Éventuellement, redimensionnez-le
(touche [S]) à votre convenance, et quittez le mode Edit (touche [Tab])
pour ne plus ajouter à ce maillage.

Maintenant, ajoutez un objet de type cône ([Espace]>Add>Mesh>Cone)
et choisissez Vertices: 4, pour obtenir une petite pyramide. Redimen-
sionnez-la (touche [S]) de sorte que la pyramide soit de faible dimension
par rapport à l’objet grille. Toujours en mode Edit, avec tous les sommets
de la pyramide sélectionnés, déplacez la pyramide et positionnez-la à la
surface de l’objet grille, au centre de celui-ci. Quittez le mode Edit
(touche [Tab]).

Ensuite, sélectionnez la pyramide (bouton droit de la souris), et ajoutez la
grille à la sélection (touche [Maj] pressée, utilisez à nouveau le bouton
droit). Établissez un lien de parenté entre les deux objets grâce à la com-
binaison de touches [Ctrl]+[P].

Maintenant, sélectionnez seulement la grille (bouton droit) et rendez-
vous dans le panneau Anim settings du menu Object, touche [F7]. Activez
l’option DupliVerts pour dupliquer la pyramide sur la surface de la grille.
Si vous effectuez un rendu, vous constaterez que tant l’objet de base que
l’objet d’origine à dupliquer n’apparaîtront pas sur l’image finale, bien
qu’ils demeurent présents dans la vue 3D.

Figure 4–26
La pyramide centrale devra être dupliquée 
à tous les sommets de la grille plane.

Figure 4–27
Le panneau Anim Settings

BON À SAVOIR   Ce qu’il faut savoir pour 
maîtriser les DupliVerts

Pour garantir un bon contrôle de l’orientation des
duplicatas à la surface de l’objet servant de base, il
convient de s’assurer que leurs systèmes d’axes
locaux (qu’il est possible d’afficher, individuellement,
grâce au bouton Axis du panneau Draw, Object
buttons, menu Object [F7]) sont orientés de la
même façon. La méthode la plus simple et la plus
rapide d’y parvenir consiste à utiliser la combinaison
de touches [Ctrl]+[A] pour appliquer l’échelle et la
rotation à l’objet.
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Option Rot des objets dupliqués

Vous pouvez tout aussi bien utiliser les objets dupliqués sur un objet sphé-
rique ou même plus complexe. Toutefois, la pyramide sera placée en l’état,
toujours verticale, conduisant à un effet visuel peut-être disgracieux.

Il est toutefois possible d’activer l’option Rot qui permet de réorienter
l’axe vertical de l’objet pour suivre la normale des facettes adjacentes au
sommet de duplication. Le résultat paraîtra ou non satisfaisant, en fonc-
tion de la forme de l’objet dupliqué, mais dans le cas d’une pyramide
avec un axe prépondérant, ce n’est certainement pas le cas.

Figure 4–28
Les pyramides ont été dupliquées

à chaque sommet de la grille, mais le modèle
d’origine ainsi que l’objet servant de base
n’apparaissent pas au rendu sur fond noir.

Figure 4–29
Duplication de pyramides sur une sphère

Figure 4–30
L’option Rot appliquée à la duplication

de pyramides sur une sphère
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Heureusement, il est possible de déterminer la direction d’orientation de
chaque axe. Par exemple, dans le panneau Anim settings, avec l’objet à
dupliquer sélectionné, activez les boutons TrackZ et UpZ pour obtenir
une jolie masse d’armes.

Vous pouvez modifier l’orientation de l’instance dupliquée, qui est nor-
malement alignée à la normale de l’objet de base au sommet concerné.
Souvent, expérimenter rapidement les différentes possibilités est plus
rapide que d’essayer de comprendre quel axe de l’instance doit être aligné
sur la normale à la surface de base au sommet considéré. Mais dans notre
cas, avec Track-X orienté sur Up Z, on se retrouve avec une masse d’armes
dont les piques sont... dirigées vers l’intérieur !

La fonction DupliFaces

Son fonctionnement est très similaire à celui de DupliVerts, la principale
différence étant qu’au lieu d’être placées à chaque sommet, les instances
apparaissent au centre de chaque facette de l’objet servant de base.
L’option Scale permet alors de dimensionner l’instance pour qu’elle
occupe au mieux la facette, s’ajustant à ses dimensions. Vous pouvez bien
sûr contrôler cette mise à l’échelle en redimensionnant manuellement
l’objet d’origine jusqu’à obtenir les proportions souhaitées.

Figure 4–31
L’orientation des pyramides dupliquées 
a été révisée grâce aux boutons TrackXYZ 
et UpXYZ du panneau Anim Settings.

Figure 4–32
La densité de l’objet de base a été un 
peu révisée à la baisse pour mieux 
montrer les pyramides orientées 
vers le cœur de la sphère grâce 
au bouton Track-Z.

ASTUCE   Transformer les clones 
en vrais objets

Si vous modifiez la forme de l’objet servant de
base, en particulier en déplaçant, ajoutant ou sup-
primant des facettes ou des sommets, les clones
seront redistribués en conséquence. De même, si
vous éditez la forme de l’objet d’origine, les modi-
fications seront répercutées sur tous les clones.
Vous pouvez soit conserver cette duplication pro-
cédurale, soit la rendre effective en transformant
chaque clone individuel en un objet à part entière.
Pour cela, vous sélectionnerez l’objet servant de
base à la distribution des clones et utiliserez la
combinaison de touches [Maj]+[Ctrl]+[A] pour
les rendre « réels ».
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Déformation procédurale de maillages : fonction Noise
Cette fonction permet de récupérer des informations stockées dans une
texture pour déformer, en proportions, un maillage existant. Une texture
en dégradés de gris est nécessaire ; les pixels noirs ou sombres indiquent
l’absence de déformation, ou un faible niveau ; les pixels blancs ou clairs
indiquent une déformation maximale, ou très élevée.

Cette fonctionnalité est souvent utilisée pour la création rapide de terrains
pour des scènes d’extérieur. Par exemple, l’image suivante, ch04-noise-
texture.png, présente sur le DVD-Rom dans le répertoire /exercices,

peut être utilisée pour obtenir le paysage suivant :

Figure 4–33
Les instances de sphères apparaissent

au centre des facettes de la grille ; avec
l’option Scale, elles sont automatiquement

redimensionnées proportionnellement
aux dimensions de chaque facette.

BON À SAVOIR   
Application de la fonction Noise

Celle-ci ne fonctionne que dans la direction Z. Si
vous avez besoin de déplacer la géométrie dans
les autres directions (voire toutes à la fois), pré-
férez l’usage du canal de texture Disp : la géomé-
trie réelle de l’objet ne sera pas déplacée, mais elle
le sera au moment du rendu.

Figure 4–34
Exemple de texture en dégradés de gris...

Figure 4–35
... et le paysage résultant obtenu !
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Pour obtenir un résultat identique, démarrez une nouvelle session (combi-
naison de touches [Ctrl]+[X]), sélectionnez (bouton droit de la souris) et
supprimez (touche [X]) le cube par défaut. À la place, insérez un plan
([Espace]>Add>Mesh>Plane) que vous diviserez plusieurs fois (en
mode Edit, avec tous les sommets sélectionnés, touche [W], choisissez Sub-
divide Multi et choisissez une valeur de 20, ou bien utilisez une grille de
résolution ResX:20 et ResY:20). Quittez le mode Edit et affichez les Mate-
rial buttons du menu Shading, touche [F5]. Cliquez sur Add New dans le
panneau Material pour ajouter un nouveau matériau, mais vous n’avez
besoin de modifier aucun paramètre pour utiliser la fonction Noise. Allez
ensuite dans les Texture buttons (touche [F5] pour faire défiler les diffé-
rentes collections de boutons), et cliquez sur le bouton Add New du
panneau Texture. Choisissez Image en guise de Texture Type puis, en cli-
quant sur le bouton Load Image du panneau Image, sélectionnez la texture
ch04-noise-texture.png présente sur le DVD-Rom. Passez ensuite dans
le menu Editing (touche [F9]) et en mode Edit (touche [Tab]). Repérez le
panneau Mesh Tools, et surtout le bouton Noise. Dans une vue 3D, faites
tourner la vue (touches [2], [4], [6] ou [8] du pavé numérique) ou passez en
vue de caméra (touche [0] du pavé numérique), en prenant soin d’activer la
vue ombrée (touche [Z]). Cliquez ensuite plusieurs fois sur le
bouton Noise, et observez comme le maillage se déforme, pour que les pics
et les vallées correspondent au plus près aux informations en noir et blanc
données par la texture. Quittez le mode Edit (touche [Tab]) et redimen-
sionnez votre décor (touche [S]).

Outil d’édition proportionnelle : PET
L’outil d’édition proportionnelle vous permet de modifier harmonieuse-
ment un maillage en ne déplaçant qu’un seul sommet à la fois ; le sommet
déplacé agira comme un aimant, et attirera dans son déplacement les som-
mets voisins, la force d’attraction diminuant avec la distance.

L’outil d’édition proportionnelle (Proportional Editing Tool, ou PET) ne
s’active qu’en mode Edit, soit grâce à la touche [O], soit en passant par le
menu de la vue 3D, Mesh>Proportional Editing, soit encore en utilisant
l’icône appropriée de l’en-tête de la vue 3D. La taille de la zone affectée
est visible en mode Edit, au cours d’une transformation (déplacement
[G], rotation [R] ou mise à l’échelle [S], par exemple), et est matérialisée
par un cercle en pointillés ; augmenter le rayon d’effet revient à aug-
menter la « force d’attraction » du sommet (ou du groupe de sommets)
déplacé(s). Les touches [PageSup] et [PageInf ] du clavier permettent res-
pectivement d’augmenter ou de diminuer le rayon d’effet. De même,
vous pouvez utiliser la molette de votre souris (si elle en est équipée) pour

ATTENTION   Taille de la texture

Votre texture a une dimension égale à une unité
de Blender de côté. Si vous redimensionnez
votre décor avant d’appliquer la fonction Noise,
prenez garde à le faire en dehors du mode Edit.
Si vous êtes encore en mode Edit et que vous
redimensionnez les sommets, arêtes et facettes,
la texture ne changera pas de taille, mais aura
probablement été répétée autant de fois que
nécessaire dans les deux directions de l’objet. Il
en résulte que les reliefs transmis par la texture
se répèteront très visiblement, et que la profon-
deur des sommets et des vallées du décor sera
amoindrie.

BON À SAVOIR   Mode Connected de l’outil 
d’édition proportionnelle

Outre l’activation (On) ou la désactivation (Off)
de l’outil, il existe un mode Connected. Grâce à
lui, l’effet proportionnel n’agit que sur les som-
mets liés, par une chaîne quelconque d’arêtes, au
sommet déplacé. En bref, lors de son déplacement,
un sommet ne peut entraîner avec lui que les som-
mets qui lui sont associés lors de l’usage, par
exemple, de la sélection au moyen de la
touche [L].

Figure 4–36 Activation de l’outil d’édition 
proportionnelle par l’en-tête de la vue
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modifier le rayon d’effet, ou les combinaisons de touches [Alt]+[+] ou
[Alt]+[-] du pavé numérique.

Vous noterez que la force d’attraction est décroissante à mesure que le
point affecté est éloigné du sommet (ou du groupe de sommets)
déplacé(s). Par défaut, la décroissance est linéaire, mais il y a divers
modes d’atténuation (Falloff).

Sur les illustrations qui suivent, le sommet central d’une grille est
déplacé grâce à la touche [G] ; le mode d’atténuation est alors aisément
mis en évidence. Les différents modes disponibles rendent cet outil par-
ticulièrement approprié à la modélisation de paysages.
• Constant : il n’y a en fait aucune atténuation ; tous les sommets dans

la zone d’effet subissent la même transformation. Idéal pour la créa-
tion de plateaux cylindriques.

• Random : l’atténuation dans la zone d’effet est totalement aléatoire.
Idéal pour la création de surfaces irrégulières.

• Linear : l’atténuation de la transformation est proportionnelle à la dis-
tance. Idéal pour la création de surfaces régulières.

Figure 4–37
Les différents modes d’atténuation de l’effet

3DS MAX   Sélection douce

Le PET est à Blender ce que la Sélection douce est
à 3ds max, à ceci près que la Sélection douce
permet un réglage fin de l’atténuation. Il manque
toutefois à l’outil de 3ds max les différents modes
d’atténuation prédéfinis du PET de Blender.

Figure 4–38
Atténuation constante (Constant)

Figure 4–39
Atténuation aléatoire (Random)

Figure 4–40
Atténuation linéaire (Linear)
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• Sharp : l’atténuation de la transformation est particulièrement rapide,
les sommets lointains n’étant pratiquement pas affectés. Idéal pour la
création de reliefs accidentés.

• Root : l’atténuation de l’effet est particulièrement lente, suivant une
loi quadratique (root, racine), permettant d’affecter significativement
même les sommets en limite de la zone d’effet. Idéal pour la création
de collines.

• Sphere : l’atténuation agit comme précédemment, mais suivant une
loi cubique.

• Smooth : l’atténuation est un peu plus amortie que pour le
mode Linear, mais plus abrupte que pour le mode Root. Idéal pour la
création de vallées.

Outil d’accrochage (Transform Snap)
Lorsque l’outil d’accrochage est actif, les transformations (déplacement
[G] et rotation [R], mais aussi certaines fonctions comme l’extrusion [E])
appliquées à la sélection peuvent être contraintes de diverses façons. Ce
mode s’active en mode Edit, soit grâce à l’icône appropriée dans l’en-tête
de la vue 3D, soit grâce à la combinaison de touches [Maj]+[Tab].

Cet outil fonctionne lorsque vous maintenez enfoncée la touche [Ctrl] ; dans
ce cas, lorsque vous déplacez votre sélection en direction d’un sommet quel-

Figure 4–41
Atténuation brutale (Sharp)

Figure 4–42
Atténuation amortie (Root)

Figure 4–43
Atténuation sphérique (Sphere)

Figure 4–44
Atténuation douce (Smooth)

Figure 4–45 Les différents 
mode d’accrochage du mode Snap

ASTUCE   Accrochage des sommets 
sur un objet tiers!

Grâce à cet outil, Blender permet non seulement
d’accrocher un sommet à un autre sommet du
maillage en cours d’édition, mais également de
l’accrocher aux sommets de n’importe quel autre
objet. Il vous suffit de sélectionner les deux objets
en question, le maillage à éditer étant la sélection
active (rose plus clair). Entrez en mode Edit[Tab]
et saisissez un sommet. Avec la touche [Ctrl]
pressée, déplacez-le [G] vers l’autre objet (qui est
toujours en mode Object) : Blender vous propose
alors d’accrocher la sélection au sommet le plus
proche du pointeur de la souris en indiquant celui-
ci grâce à un petit cercle blanc !
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conque du modèle en cours d’édition, celui-ci est encerclé de blanc dès que
le curseur de la souris est suffisamment près du sommet visé. La sélection
s’accroche alors à ce sommet, suivant le mode sélectionné. Si la position vous
convient, vous pouvez alors la valider avec la touche [Entrée] ou grâce au
bouton gauche de la souris (le bouton droit annule la manipulation).

Cette fonction est donc très utile lors d’opérations de modélisation
nécessitant un placement précis de sommets les uns par rapport aux
autres, comme lors de la modélisation d’éléments mécaniques ou archi-
tecturaux. Elle est toutefois tout autant utile lorsque vous avez modélisé
séparément différents éléments organiques (une main, une oreille, etc.)
et que vous cherchez à les attacher précisément (au bras, à la tête, etc.).

Le mode Transform Snap admet quatre modes de fonctionnement :
• Closest : dans ce mode, la sélection sera accrochée au sommet de des-

tination par son sommet le plus proche de celui-ci, en fonction du
mouvement de transformation effectué (fonctionne avec [G] et [R]) ;

• Active : comme précédemment, mis à part que la sélection sera accro-
chée au sommet de destination par son sommet actif (c’est-à-dire le
dernier sélectionné, dans le cas d’une sélection multiple de sommets) ;

• Median : dans ce mode, la sélection sera accrochée au sommet de destina-
tion par son barycentre (centre géométrique) (fonctionne avec [G] et [R]) ;

• Center : ce mode semble fonctionner de la même façon que le
mode Median, mais la différence est très subtile, car le type de point

Figure 4–46
Avec le mode Closest, la sélection

est accrochée au sommet de destination
par le sommet le plus proche au cours

de la transformation.

Figure 4–47
Avec le mode Median, la sélection

est accrochée au sommet de destination
par son centre géométrique.
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pivot a son importance. Positionnez le curseur 3D à un endroit particu-
lier par rapport à la sélection ; dans l’en-tête de la vue 3D, choisissez le
mode d’accrochage Center ; choisissez également 3D Cursor comme
pivot de transformation ; la sélection sera accrochée au sommet de des-
tination relativement à la position initiale du curseur 3D. Si, en plus,
vous positionnez le curseur 3D sur un sommet particulier (combi-
naison de touches [Maj]+[S]), la sélection sera déplacée de manière à
faire coïncider ce sommet avec le sommet de destination, pratiquement
comme dans le mode Closest (fonctionne avec [G] seulement).

Il est également possible d’utiliser les contraintes de transformation (par
exemple, touche [G] pour initier un déplacement, puis touche [X] pour
contraindre celui-ci dans la direction X seulement) pour limiter l’accro-
chage dans une direction particulière.

Outils de modélisation avancés
Les outils qui vont être présentés ici permettent d’effectuer des manipu-
lations intéressantes au niveau des arêtes, des sommets ou des facettes.
Elles sont surtout réservées aux utilisateurs confirmés de Blender, ainsi
qu’à tous ceux qui se sentent suffisamment motivés pour se lancer dans
de véritables travaux de modélisation.

Bases de la modélisation polygonale : ajouter des sommets
Cette opération est parfaitement à la portée d’un utilisateur débutant,
mais a été glissée dans les outils de modélisation avancés pour des rai-
sons de consistance.

Si vous souhaitez créer un nouveau maillage de toutes pièces, sélec-
tionnez le cube par défaut de la scène, et passez en mode Edit
(touche [Tab]). Sélectionnez tous les points de contrôle (touche [A]) et
effacez-les (touche [X]). Votre objet est vierge de tout maillage, mais
existe toujours. En maintenant la touche [Ctrl] pressée, créez un premier
point avec le bouton gauche de la souris. Si vous cliquez à nouveau

Figure 4–48
Avec le mode Closest et 3D Cursor comme 
point pivot de transformation, il devient 
possible d’accrocher la sélection par un point 
arbitraire et immatériel ne correspondant 
ni à un sommet, ni au centre géométrique.

BLENDER   Support des Ngons

Il s’agit d’une fonctionnalité que Blender ne pré-
sente pas, au contraire d’autres logiciels commer-
ciaux. Parce que cela est considéré comme une
limitation majeure par certains utilisateurs, les
Fgons (fake gons) ont été implémentés, pour la
compenser un tant soit peu. Il est également ques-
tion de les inclure véritablement dans une pro-
chaine version.
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ailleurs avec le bouton gauche, toujours en maintenant la touche [Ctrl]
pressée, vous ajoutez un second point, relié au précédent par une arête.

Bases de la modélisation polygonale : fonction Fill
Cette fonction est particulièrement versatile, et a plusieurs usages.

Si vous avez dessiné un profil ouvert à l’aide de sommets reliés entre eux
par des arêtes, vous pouvez sélectionner le premier et le dernier sommet,
et utiliser cette fonction (touche [F]) pour fermer le profil en ajoutant
l’arête manquante.

Vous pouvez également sélectionner trois sommets quelconques, et uti-
liser cette fonction (touche [F], à nouveau), pour créer une facette trian-
gulaire à partir des trois sommets. Cela fonctionne aussi pour la création
de facettes quadrangulaires à partir de quatre sommets.

Enfin, dernière possibilité intéressante de cette fonction : si vous avez
constitué un réseau d’arêtes, plutôt que de les fermer individuellement
par des facettes, sélectionnez-les toutes, et la touche [F] (option Auto)
constituera automatiquement toutes les facettes triangulaires ou qua-
drangulaires qu’il lui sera possible.

Figure 4–49
Exemple de modélisation polygonale,

© 2005 Adrien Lourdelle,
http://adrien.3dvf.com

Figure 4–50
Le menu Make Faces 
accessible par la touche [F]

ASTUCE   Création de Fgons

Certains utilisateurs ayant réclamé à corps et à cris
le support des Ngons (polygones à n côtés) dans
Blender, et la communauté étant fortement divisée
sur l’intérêt du sujet, les développeurs ont ajouté
la possibilité de sélectionner plusieurs facettes et
de créer un « faux Ngon » en appuyant sur la
touche [F]. Il s’agit bien sûr d’un faux polygone,
dans le sens où Blender ne sait véritablement
gérer que des quadrangles ou des triangles, et que
les arêtes internes au Fgon sont simplement mas-
quées. Certains utilisateurs trouvent cette fonc-
tionnalité absolument indispensable pour la
production de maillages de toute beauté, tandis
que les autres trouvent cet ajout cosmétique pure-
ment inutile.

ASTUCE  Skin Faces/Edge-Loops

Cette fonction permet de créer la géométrie man-
quante à la jonction entre deux boucles (que ce
soient des boucles de faces ou des boucles
d’arêtes). Idéalement, les deux boucles doivent
avoir le même nombre de sommets pour l’établis-
sement de la jonction, mais cela n’est pas obliga-
toire, l’outil étant suffisamment souple pour
s’accommoder d’écarts importants : des menus
supplémentaires apparaissent alors pour vous
demander comment gérer la fonction.
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